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Getting Started with SolidView
The SolidView family of Products consists of SolidView/Lite, SolidView,
and SolidView/Pro.  Within this document, the term “SolidView” will refer to
any of the SolidView products.

SolidView is a powerful, yet easy to learn, Windows application designed to
communicate 3D and 2D design information.  Typically, this information was
created on a  Computer Aided Design (CAD) system, but you do not need to
be familiar with a CAD system in order to use SolidView.  In fact, SolidView
is designed to be used by anyone who normally uses 2D drawings.  And since
SolidView is an interactive 3D application, most people find it easier to use
than 2D drawings.  This booklet briefly describes the basic features of
SolidView.  For a complete description of SolidView capabilities, see the
Svdemo.sfx file in the SolidView installation directory or the complete on-line
help system.

If you have not already installed SolidView, please see Installing SolidView
on Page 15.  You can also run SolidView/Lite from the SolidView CD without
installing any software on your computer.

Viewing 3D Data
SolidView has three primary functions: View, Measure, and Communicate.
The most basic function of SolidView is viewing 3D designs.  The first step in
using SolidView is to load a 3D file.  SolidView can read a variety of 3D file
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formats such as STL and VRML files, and
options are available to read other for-
mats such as IGES.  Select the Open
menu item in the File menu to load an
STL file.  STL files consist of a series of
facets or triangles that represent an ob-
ject or shape, typically a mechanical de-
sign generated on a CAD system.

An STL file called arm1.stl is included
in the SolidView installation directory
and it’s a good file with which to get

started.

SolidView’s simple view buttons make it easy to move the model in the direc-
tion indicated by the arrows.  The curved buttons rotate the model, while the
flat buttons move and zoom the model.  Simply click with the left mouse but-
ton to change the view as required.  Using the right mouse button performs the
same function, but in bigger steps.  Go ahead and see how each button changes
the view.

SolidView supports a number of “standard” views, which can be selected by
using the View drop down list in the view control dialog.

SolidView also supports a number of display or rendering modes.  Since
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SolidView performs very well on standard PC hardware, it is usually best to
view models in the default Shaded mode.  The other modes can be selected
using the Rndr drop down list in the view control dialog.

To learn about the functions of the other buttons in the view control panel,
simply click on the Win button and hit the F1 function key to activate
SolidView’s on-line help.

You can also rotate an object by holding down the right mouse button and
moving the mouse over the view area.  With practice, you will find that this is
a very easy way to position an object.  If SolidView detects that it is taking too
long to generate the image when you rotate it this way, it will display and move
an outline that represents the object until you stop moving the mouse.  This
way you can still interactively position the object, even if you are using a slow
computer, or working with a very complex object.

Viewing 2D Data
SolidView also lets you view and markup 2D raster and vector images.  This
feature is designed to enable detailed engineering information, usually only
found on 2D drawings, to be displayed alongside SolidView’s 3D images.  A
2D image or graphic can be added to any SolidView slide by simply clicking

on the Add Graphic  tool button.  This will bring up a file open dialog
where the proper 2D graphic can be selected.  A 2D graphic window can be
activated by selecting the 2D graphic.
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Once activated, the 2D toolbar  will be displayed in the 2D graphic window.
The function of each tool button can be displayed by moving the pointer over
each button without clicking on the button.  You can also view a 2D image by
using SolidView’s File | Open menu.

Managing 2D Images
Once a 2D image has been added,
the image size can be changed by
simply clicking on the corner or side
of the image as you can do with any
standard Window.  As with the 3D
display in SolidView, you can also
pan the image by holding down the
Alt key while pressing the right
mouse button.

The Windows menu item makes it
possible to cascade and tile the 2D
images, as well as hide and show the
images.  It is important to note that

each time a 2D image is added to SolidView, only one copy of that file is
loaded and saved in the SolidView file, even if you use the 2D Graphic button
to load the same image multiple times.  Depending on your communication
intent, you may want to have only one 2D image on each SolidView slide, or
you may want to have multiple minimized images on one slide—SolidView
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gives you the complete flexibility to choose.

A 2D CGM (Computer Graphics Metafile) file called Arm1.cgm is included
in the SolidView installation directory.  Click on the Add Graphic tool button
and select this file.  Using the 2D tool buttons, you can create a view that
displays the 3D object, a 2D GD&T callout, and the full 2D drawing.

2D Image Options
Double clicking on a 2D image will display the Markup Graphic Options dia-
log.  This dialog has two tabs, Options and Text.  The Options tab enables you
to set a variety of options that control the way 2D images are displayed.  Use
SolidView’s context sensitive help to display the functions of each option.
The Text tab can be used to set the font, font size, and color of the text of the
minimized 2D image.

Measuring with SolidView
The second primary function of SolidView is measuring a 3D design.  For this

example, we will use the
Arm1.stl file that is included in
the SolidView installation di-

rectory.  Please load this file if you have not already done so.

You have probably already noticed the SolidView toolbar along the top of the
SolidView window.  Each button in the toolbar performs a SolidView function
and eliminates the need to use menu items for most SolidView operations.
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Simply use the mouse to point to a button (but don’t click on it!) to see the
name of the function to be performed.  The buttons can be used to measure
various features of a design.

Move the mouse over each one to familiarize yourself with their functions.
Click on the Measure Object button and SolidView will calculate everything
from the basic dimensions of the object to its volume and surface area.

You will notice the information is displayed in the Measure Object dialog as
well as on the model itself.

Clicking on the Done button in the
dialog will clear the information.  If
you want to clear the dimensions from
the model, use the Erase Annotations
button or Erase ALL Annotations but-

ton, as shown here:    You

can also use the Del key to erase the
selected annotation.

Once you have erased the annota-
tions, use the View menu in the view
dialog to select the IsoMetric view

of the Arm1 model.  Then click on the Measure Arc button.
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Next use the mouse to select the hole on the top of the object.  SolidView will
then calculate the diameter and other features of the arc and display the infor-
mation in the dialog on the right.  SolidView also creates a diameter dimension
on the model.  If you want to change the attributes of the dimension, such as
the text size, simply double-click on the dimension.  Using the other measure-

ment buttons, you can measure dis-
tances between faces, edges, and
vertices, as well as angles and other
design features.

Section Views
With SolidView, you can define a
section for viewing, measuring, and
exporting to a 2D DXF file.  To de-
fine a section, use the Measure |
Define Section menu item, or click
on the Define Section tool button.

The Define Section dialog is used
to identify the section plane and position, as well as how the section is dis-
played.  To position the section plane, use the slider or click on the object.  The
C button will center the section plane on the object and the A button will
animate the section through the object or objects.  Once the section has been
properly positioned, click on the Done button to complete the operation.  Once
the section has been defined, you can use any of SolidView’s measurement
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tools to measure features of the section.  Multiple objects can be sectioned at
one time by using the Select menu  item to select the objects prior to defining
the section.

In addition to creating measurement dimensions,
SolidView also lets you add text, notes, boxes,
arrows, and red-line markups using the follow-

ing buttons:

Collectively, these are called annotations, and in the next section you will see
how they can be used with SolidView’s record and playback capability to fa-
cilitate true design communication.

Design Communication with SolidView
With SolidView it’s easy to add markups, such as arrows, circles, text, and
notes, to a 3D view or 2D image.  These markups can be used to highlight
errors, suggest changes, or to call attention to particular design features.  Any
markup can be added to a 2D image, with the exception of another 2D image.
Markups must begin and end inside a 2D image—they cannot extend outside
of the image.

One of SolidView’s most powerful features is its ability to record and play-
back multiple views or “slides”.  Each slide can have its own set of measure-
ments or annotations, as well as its own views of the model.  This makes it
possible to create an “electronic” design review for effective design communi-
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cation.
To create a simple slide show with SolidView, first add a few annotations to

the model and then select the Save Slide button:  

This will bring up the save slide dialog where you can rename the slide, add a
description, and set a display time.  After you have saved the first slide, use the
Erase ALL Annotations button or the Del key to clear the annotations that will
not be in the next slide.  You can then add any new annotations or 2D images,
change the view, or create a section view before you save another slide.

Once you have saved all the slides, you can replay them using the slide play-

back buttons:  

Managing Annotations
SolidView makes it easy for multiple people to review and comment on a
design.  A feature called authoring keeps track of who adds annotations to an
SFX file and when they were added.  Navigation tools enable users to review
existing annotations based on author.  To use this feature you must select the
Annotate | Authoring Mode menu item.  Once authoring has been enabled,
you must register as an author before you create any annotations.  Select the
Annotate | Author Registration menu item to display the Author Registra-
tion dialog.  If desired, you can add a password to prevent others from chang-
ing your annotations, and you can select a color scheme to make your annota-
tions easy to identify.  In order to properly review authored annotations, you
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must save at least one slide, using the SolidView Save Slide button .  If authoring
is enabled, but no author is registered, any attempt to create an annotation will
result in the Author Registration dialog being displayed.  To review annota-
tions, select the Annotate | Author Navigation menu item to display the Au-
thor Navigation dialog.  The Author Navigation dialog has options that enable
you to set the way in which annotations are displayed.  Once author navigation

is enabled, use the slide playback buttons  to review

the annotations.  Please note that if author navigation is enabled, but no au-
thors are selected to be shown, no annotations will be displayed.

Saving Annotations and Slides
The STL file format that SolidView uses does not support things like slides
and annotations.  In order to save these features with your model, you must
save the file in SolidView’s SFX format.  In addition to saving all the annota-
tion and slide information, SFX files have the additional benefit of being much
smaller than standard STL files.

This would be a good time to go ahead and save your file by using the Save
SFX function in the File menu.  Once you have saved an SFX file, this file can
be sent to anyone who needs to view the slides and annotations you have cre-
ated.  You might think that they would need a copy of SolidView in order to
read the SFX file, but that is not the case.  In order to provide effective design
communication, SolidView can “publish” an SFX file, complete with a copy
of SolidView/Lite, which allows the recipient to view the slides and annota-
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tions you have created.  In fact, SolidView/Lite includes most of the viewing
and measuring capabilities of SolidView, but it only operates on SFX files.
You can freely distribute copies of SolidView/Lite, subject to the SolidView/
Lite license agreement.

Publishing SFX Files
To publish an SFX file, complete with a copy of SolidView/Lite, simply select
Publish SFX from the File menu.  SolidView will prompt you for a file name,
and then display the publish dialog.

Published files are always executable files (of type EXE) because they are
actually multiple files saved as a self-extracting program.  Within the publish
dialog, you can set a password or include SolidView/Lite.  The password is
useful if you are sending the published file over the Internet as the file cannot
be extracted without the password.  Since many systems block emails contain-
ing .exe files, it may be preferable to simply save an .sfx file and forward a link
to www.solidview.com where the recipient can download SolidView/Lite for
free.

Once you have published a file, it can be sent to anyone with a Windows PC,
using any method suitable for transmitting a binary computer file.

Printing with SolidView
SolidView is designed to work with both color and monochrome Windows

http://www.solidview.com
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printers.  Select the File | Preferences menu item and then select the Printing
tab to set the printing options.  Press the F1 function key to display on-line
help for the SolidView printing options.

Creating VRML and HTML data
You can save your SolidView files in VRML and HTML formats for viewing
with standard web browsers.  Use the File | Save SFX menu item and select a
file type of HTML, VRML 1.0, or VRML 2.0.

Interactive Viewing Controls
Arc Ball Right Mouse
Axis Arc Ball Right Mouse + Ctrl Key
Zoom Window Left Mouse + Alt Key
Drag Zoom Left Mouse + Ctrl Key + Alt Key

Right Mouse + Ctrl Key + Alt Key
Drag View Right Mouse + Alt Key
Move Light Right Mouse + Shift Key
2D/3D Pan Middle Mouse
Zoom Intellimouse wheel

Standard SolidView 3D File Formats
OBJ Object file (Alias, Wavefront)
SFX SolidView
SLDPRT SolidWorks part file
SLDASM SolidWorks assembly file
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STL Stereolithography
SV SolidView 1.0 format
WRL VRML Virtual Reality Modeling Language

Optional SolidView/Pro File Formats
Direct interfaces for reading native 3D and 2D CAD and industry standard
data files are available for SolidView/Pro.  Called “Plugins”, these optional
interfaces enable non-CAD users to view and measure native CAD data
without any translation.  Plugins for Pro/E, Catia, Unigraphics, SDRC,
STEP, Parasolids, IGES, VDA, ACIS, SolidEdge, and other formats are
available from your Authorized SolidView reseller.  See
www.solidview.com or click on “Supported File Formats” in SolidView’s
online Help for the latest information on the available CAD interface
plugins.

Supported SolidView/Pro 2D File Formats
BMP OS/2 or Windows bitmap PCT Macintosh PICT
CGM Computer Graphics metafile PCX ZSoft Paintbrush
DXF Autodesk Interchange PNG Portable Net. Graphics
DWG Autocad drawing RAS Sun Microsystems
EMF Enhanced Windows metafile TARGATruevision
GIF CompuServe TIFF Tagged Image File Format
HPGL HP Graphics Language TXT Text document
HPGL2 HP Graphics Language WMF Windows metafile
JPEG JPEG group

http://www.solidview.com
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OpenGL Hardware Acceleration
If you have a graphics board that supports OpenGL accelerated graphics,
you can enable this by selecting the Hardware Acceleration option under the
Rendering tab in the File | Preferences dialog.  By default, hardware
acceleration is disabled in SolidView as the latest video drivers may be
required in order for a particular graphics board to operate correctly.  If you
encounter problems while using hardware acceleration, you should contact
your video board supplier and verify that you have the latest video drivers
installed.

SolidView DDE Interface
SolidView supports Dynamic Data Exchange (DDE).  DDE is an established
protocol for exchanging data between Windows-based applications.  For
more information on SolidView’s DDE commands, see the DDE topic in
SolidView’s online help, or the Access or DDE directory in the Samples
folder on the SolidView CD-ROM.

Learning More About SolidView
In addition to the features described in this booklet, SolidView has many
more features designed to make it easier to communicate design informa-
tion.  SolidView’s complete on-line help provides reference information for
all SolidView functions.  If you need additional help, or if you have any
questions regarding SolidView, you should contact your SolidView reseller,
visit www.solidivew.com or you may contact us via email at

http://www.solidview.com
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support@solidview.com.  You can also contact us via the World Wide Web,
phone, or fax, as shown on the back of this booklet.

SolidView Licenses
SolidView/Lite does not require any license key or registration process.  It
may be installed on one computer and shared over the network, subject to the
terms of the SolidView/Lite License Agreement.  The SolidView product can-
not be shared over the network.  SolidView/Pro may be shared over the net-
work, if you have purchased a Network license.  If you did not purchase a
SolidView/Pro Network license, you can only access SolidView/Pro from
the computer on which it is installed.  Whether your installation is a Network
License or Single-Computer License is determined by the Program Key en-
tered at the end of the installation process.  Regardless of the license type, the
basic installation process is the same.

Installing SolidView
The SolidView CD-ROM contains SolidView software, demonstration files,
and sample data files.  To install SolidView software, run or install the
demonstration files, or browse the contents of this CD-ROM, insert the
SolidView CD in your CD-ROM drive.  If the Setup program does not start
automatically then:
1. From the Start menu, select Run.
2. In the Open field, enter x:\setup, where x is the letter of your CD-ROM

drive.
3. Select OK.

mailto:support@solidview.com
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The first time you run the Setup program, you will be prompted to enter your
SolidView serial number from the back of this booklet or the CD-ROM jacket.
After the Setup program  has started, you will have menu options to view
demos, install any SolidView products or options, learn more about SolidView,
or browse the CD.

At the end of the installation procedure, you will be prompted for a Program
Key.  You must contact your authorized SolidView Reseller, or Solid Concepts
(phone 661-257-6699,  fax 661-295-6877, or email support@solidview.com)
to obtain a password and run SolidView.  Registered users can obtain a per-
manent or trial key 24 hours a day from www.solidview.com.  Click on the
Help button in the Program Key Required dialog for more information on how
to obtain a Program Key.

SolidView/Pro Network Installation
SolidView/Pro can be installed on a network under a number of concurrent
users license.  SolidView/Pro can only be installed on a network if you have
purchased a SolidView/Pro network license.  A SolidView/Pro network
license allows a specific number of SolidView/Pro users to access a copy of
SolidView/Pro installed on a server.  The networked version of SolidView/
Pro will run on any network that supports the following:

SolidView/Pro Program Directory
A Network Directory mountable with a drive letter by a Windows
Client for at least read access.  This directory will contain the installed

mailto:support@solidview.com
http://www.solidview.com
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SolidView/Pro executable program.
SolidView/Pro NetLicense Directory

A Network Directory shared for read/write with a UNC name (Univer-
sal Naming Convention).  This directory will contain the network
license file.  All clients MUST be able to read/write the file.

The Microsoft Windows network meets these requirements.

Server Installation
The SolidView/Pro server may be Windows NT, Windows 95/98/ME , any
Windows 2000, Windows XP, or any other FILE SERVER supporting the con-
ditions above.  If you have purchased a SolidView/Pro Network License, you
will be prompted to select the network installation type, either Network Drive
or Windows File Sharing.  In general you should select the default Network
Drive option.  If you are using Windows 95/98/ME as your SolidView/Pro
server and you are concerned about giving users write access to the SolidView/
Pro program directory, you can select Windows File Sharing and create a sepa-
rate Read/Write share for the SolidView/Pro NetLicense Directory.

The default network installation will use the following directories:
SolidView Program Directory:
 c:\Program Files\Solid Concepts Inc\SolidViewPro to be shared as
\\<SERVER>\SolidViewPro.
This directory must be mapped by the clients with a drive letter
 such as S:
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SolidView NetLicense Directory:
c:\Program Files\Solid Concepts Inc\SolidViewPro\SVIEWNET to be
shared for WRITE access as \\<SERVER>\SVIEWNET
This directory is not mapped by the clients.

Installation Steps:
1 Install SolidView on the Server. You will not be prompted for any of the

network parameters until after you have entered your SolidView/Pro
program key.

2 You must contact your Authorized SolidView Reseller or Solid Con-
cepts (phone 661-257-6699,  fax 661-295-6877, or email
support@solidview.com) to obtain a password and run SolidView.  You
can obtain a network key 24 hours a day from www.solidview.com.
Click on the Help button in the Program Key Required dialog for more
information on how to obtain a Program Key.

3 Select the network installation type.
After entering the SolidView/Pro program key, you will be given the
choice of selecting a Network Drive or Windows File Sharing installa-
tion.

4 Specify the NetLicense Directory on the Server.
SolidView will prompt you for a network directory such as

mailto:support@solidview.com
http://www.solidview.com
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c:\sldview\sviewnet.  This directory will be used to track network
licenses and must be shared with read/write access for all clients.
Using a subdirectory is recommended since it protects application files.

5 Specify the UNC name to the NetLicense Directory.  SolidView will
then prompt you for the UNC network path for the NetLicense directory
created above.  The network path must follow the UNC (Universal
Naming Convention) format which consists of two back slashes ‘\\’
followed by the server name, followed by another back slash ‘\’ and the
network share name such as \\<SERVER>\directory. SolidView clients
will use this network path to access the license file ‘sldview.net’.

6 Exit SolidView/Pro.

7 Configure your server to share the SolidView/Pro install directory
(c:\Program Files\Solid Concepts Inc\SolidViewPro) with read access
for all clients.

8 Configure your server to share the SolidView network directory
(c:\Program Files\Solid Concepts Inc\SolidViewPro\sviewnet) with
read/write access.

9 If you want SolidView to create a log file to enable monitoring of the
network license, create a MS-DOS text file with the name “sldview.log”
in the \sviewnet folder.
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Network Client Installation
1 Connect to the server and network drive where SolidView/Pro was

installed using the Network Neighborhood icon or the File Manager.
(The share name \\<SERVER>\SolidViewPro should be what you want.
Check with your Network System Administrator, if needed.)  Since you
will need access to this same network drive with the same drive
letter, it is highly recommended that you specify that the connection
is reestablished next time you log in.

2 Run SolidView/Pro.
Using the File Manager or Explorer, open the drive mounted above and
double click on ‘sldview.exe’ or use the Program Manager’s run
command and specify <s>:\sldview.exe where <s> is the drive letter you
specified when mounting the SolidView Program Directory above.

3 SolidView will prompt you to determine if you want to perform
Network Setup (this allows each Client to have its own SolidView/Pro
defaults).  Select OK to continue with the Client Network Setup.

4 SolidView/Pro will then prompt you for a local directory to install de-
faults and other information (< 200K required). This directory will be
used to save the user’s default settings in a file called ‘sldview.df’.
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5 SolidView/Pro will then prompt you for a Program Group Name.  Several
icons and start menu options will be created for accessing SolidView/Pro
and SolidView Help.

This concludes the Network Client Installation Process.
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